
New Trader UI- Participant User Guide 

1.1.0 About Inputs 
Inputs from participants to eCat include: 

• Capacity Bids that can be manually uploaded as ECAN Bid Document file v4r0 or CIM format
via the menu File > Upload or entered on the GUI.

• Resale Notifications that can be manually uploaded as ECAN Rights Document file v4r0 via the menu File 
> Upload or entered on the GUI.

• Default Bids that can be manually entered through the GUI. 
• Transfer Notifications that can be manually uploaded as ECAN Rights Document file v4r0 (or

entered on the GUI).
• Balancing Reservation that can be manually uploaded as ECAN Rights Document file v4r0 (or

entered on the GUI).

1.1.1 About Data outputs 
Data outputs to participants from eCAT include: 

• Confirmation of Registration in the System received via email by the participants.

• Auction Characteristics, displayed in the GUI and published on JAO’s website.

• Bid and resale Acknowledgment Document (ENTSO-E ACK document) received via email by 
the participants and downloadable through the GUI by the participants.

• Allocation Result Document (ECAN Allocation Result document v4r0) downloadable through the
GUI by the participants.

• Capacity Right Portfolio Document (ECAN Rights Document file v4r0) downloadable through the
GUI by the participants.

• Transfer Confirmation as ECAN Rights Document file v4r0 received via email by the participants
and downloadable through the GUI by the participants.

• Long-Term Programming Authorizations as ECAN Rights Document file v4r0 received via email
by the participants and downloadable through the GUI by the participants.

• Daily Programming Authorizations as ECAN Rights Document file v4r0 received via email by
the participants and downloadable through the GUI by the participants.

• Day Ahead Min/Max AAC as ECAN Rights Document file v4r0 received via email by the participants
and downloadable through the GUI by the participants.

• Settlement Results as Excel document downloadable through the GUI by the participants



  

 

 
 

1.2 A Look at the GUI 
ECAT is accessed through a web-based GUI. The following figure shows the 

Main screen. This screen is the GUI’s primary access point to the system features and functions. 
 

Figure 2 – Main Screen 
 
 

 

1.2.1 Main Screen 
From the main screen, as from any other screen, all eCAT Participant screens can be reached. These screens present 
the major features and functions to buy capacity, transfer or resell capacity, review capacity right portfolios and 
programming authorizations. 

• The menus offer features for performing standard functions such as auction review. Clicking on a 
menu title causes the menu to drop down. 

 
 

 

1.3 Screen Layout 
The eCAT screens share a common layout, with: 

• Filtering criteria pane: the topmost area offers a set of filters that can be used to search auctions, 
bids, events or allocation results, depending on the screen currently displayed. 

• List pane: In the center, the search result is displayed as a list of items. 

Each row provides some summary information on an auction, a bid, a file or an event. The list may also 
display a few action icons for each row, providing a quick way to open or download a file, or to create, 
modify or cancel a bid. 

• Details pane: The bottom part of the screen shows all the details about the item currently selected 
from the list. For an auction, that would be its identification details, the product and the capacity 
offered or gates. 
All this information is organized in multiple tabs. 



  

 

 

 

Figure 3 – GUI Screen Layout 
 
 

 

1.4 Menu Hierarchy 
The Main screen gives access to the various displays of the application through the menu bar, at the top of the 
screen, by clicking on a menu or a submenu item. 

Every stage in the lifecycle of an auction has one or more screens dedicated to it: 

• All documents either produced by or submitted to the ECAT system are available from a single 
screen through Management submenu in File menu. 

• Once an auction has been published, it can be reviewed in the Auction Display submenu through 
Auction menu. 

• Participants can submit and review Bids through New/Edit Bids submenu in Bid menu. 

• Participants can display the different versions of Bids in read-only mode through Bid List submenu in 

Bid menu. 

• Participants can submit and review Default Bids through New/Edit Default Bids submenu 
in Bid menu. 

• Participants can review Shadow and Default Bids through Shadow / Default Bids submenu 
in Bid menu. 

• As soon as an auction has finished, the eCAT system computes and publishes the allocation 
results through Allocation results submenu in the Capacity Right menu. 

• The details of Capacity Right portfolios can be seen through the Capacity Right List submenu in the 
Capacity right menu. 



  

 

• The details of Programming Authorizations can be seen through the Display submenu in the 
Programming Authorizations menu. 

• The modification of the designated ITR could be made through the New ITR Designation 
submenu in the Programming authorizations menu. 

• All secondary market operations (Transfer/Resale) can be performed and checked through 
Secondary market menu and its submenus. 

• The settlements can be exported through the Settlement menu. 

• The entitlements can be displayed through the Entitlements menu. 

• Participants can submit and review messages through Bulletin Board and its submenus. 

 

In addition, the Options menu [Settings icon ] allows users to change their password, the display time 

zone. The following diagram shows the Main Unit screen’s menus and the options available from them. 

Figure 4 – Drop-Down Menus 
 

 

Figure 5 –Menus 

 Clicking on a menu title causes the menu to drop down 



  

 

1.5 Navigating with the GUI 

1.5.1 Loggin In and Out 

 To log in to the eCAT GUI 

1. Open a new browser window. 

2. Go the Start Session page of eCat located on JAO website. 

3. Select your personal electronic certificate to use. 

4. At the Login page, enter your User ID and Password in the appropriate fields. Note that the login fields 
are case sensitive. 

5. Select the Time Zone 

6. Click the Login button and the Applications opens. 
 

Figure 6 – Login Page 

 

 To log out from the eCAT GUI: 

• Select the Logout option from the Options menu [Settings icon ]. 
 

Figure 7 – Logout menu 

 
This terminates your session and brings you to the Login Page. 



  

 

1.5.2 Controlling Frames, Tabs, Menus, and Calendars 

 

1.5.2.1 Frames 

 To show and hide a frame: 

• Click on the Show/Hide control in the upper left corner of the frame. 
 

Figure 8 – Showing/Hiding Frames 

 

 To expand/collapse a frame: 

• Click on the Expand/Collapse control [represented by two opposite arrows ] in the upper 
left corner of the frame. It allows to expand the table to full screen. 



  

 

 

 
 

Figure 9 – Expanding/Collapsing Frames 

 

1.5.2.2 Tabs 

 To select a tab: 

• Click on tab name. The selected tab will be displayed. 

• Click on the right/left arrows. The “hidden” tabs on the right/left will be displayed. 



  

 

 

 

Figure 10 – Selecting tabs. 

 

1.5.2.3 Drop-down Menus 

 To expand a drop-down menu: 

• Click the menu name. 

 To close a drop-down menu: 

• Click outside the menu. 
 

Figure 11 – Drop-down menus 
 
 

 

1.5.2.4 Calendar Controls 

 To launch the pop-up calendar for date selection, Click the calendar icon. 

 To select a date: 

• Launch the pop-up calendar, click the scroll arrows to pick a month and year, and then select a date. 

• To select a year click on MONTH YEAR (ex JAN 2022) 

 To dismiss pop-up calendars: 

• Click outside local frame area. 



  

 

 

 

Figure 12 – Calendar Popup. 
 

 

1.5.3 Working with Display Records and Other Text-Labelled Items 

 To select a display record and other text-labelled items: 

• Click on the text. For example, to select a data row on a screen, place the cursor over the row 
text and click the right mouse button. 

 

Figure 13 – Clicked on Text to Select Screen Items. 



  

 

1.5.4 Filter & Sort Displays 
Filtering can be done through a dedicated pane. 

Filters and Sort are also available at table level. 

 

1.5.4.1 Filter Pane Functionalities 

 To filter display records: 

• In the Tooltray, select Filter. 

• For example in Auction Management, 

o Check the Corridor in the Corridor selection frame (with the scrollbar display all the list). 
Multiple selections are allowed or enter a keyword to restrict the displayed list). 

o Choose the Horizon in the Horizon selection (Multiple selections are not allowed), 

▪ If you select, in the pull-down menu, Yearly as Horizon, the Market Period field displayed 
different years. 

▪ If you select Monthly as Horizon, the Market Period field displayed different years and a new 
field with all the months. 

o Check the Auction state in the Auction state selection. Multiple selections are allowed. 

o Check the Version in the Version selection. Multiple selections are allowed. 

• Click on the Refresh button. 
 

Figure 14 – Filter Row. 



  

 

1.5.4.2 Table Functionalities 

1.5.4.2.1 Column Functionalities 

Common column elements for all windows tables are: 

• A funnel symbol is located at the top right corner of the table headers (hidden by default). 
 

Figure 15 – Funnel symbol – Column options icon 

Under this symbol, several option tabs are available. 

o Column Option tab 
o Filter tab 

o Column Selection tab 

 

• A Sort icon (arrow) is located at the top right corner of the table headers (hidden by default). 

 

Figure 16 – Sort symbol 

1.5.4.2.1.1 Column Option Tab 

 To display Column Options: 

• Mouse over the header of the column. A funnel icon appears. 

• Click on the icon. 

• Three tabs appear. Column Option tab is represented by a hamburger symbol (first one). 

• Click on it. 

 
The following options are available in this tab: 

• Pin Column: Thanks to this option, the user can pin the column on the left, right or unpin it. 

• Reset Sort: The user can reset the sort he has previously applied on this column. 

• Hide: Thanks to this option, the user can hide the column. 

• Autosize: The user can automatically adjust the columns width. 



  

 

 

 

Figure 17 – Column Option tab – options. 

1.5.4.2.1.2 Filter Tab 

 To display Filter tab: 

• Mouse over the header of the column. A funnel icon appears. 

• Click on the icon. 

• Three tabs appear. Filter tab is represented by a funnel symbol (middle one). 

• Click on it. 

 
Filters in the filter menu can be text boxes, date boxes, check boxes... depending on the type of data displayed in 
this column. In case of check boxes, a search filter is available. 

 

Figure 18 – Filter Column tab 

To fill a filter, the user must select the filter value (e.g.: String, dates or select a value in the list see Figure 18 – Filter 
Column tab ) and then click on Apply to apply the change. Once done, the filter menu disappears, and the window 
will be refreshed. 

A filter menu has a Reset option, this option will remove the current filter. The window will be refreshed. 

 



  

 

1.5.4.2.1.3  Column Selection Tab 

 To display Column Selection tab: 

• Mouse over the header of the column. A funnel icon appears. 

• Click on the icon. 

• Three tabs appear. Column Selection tab is represented by a table symbol (last one). 

• Click on it. 

 
A list of the columns available in the table is displayed. The user can select/unselect the columns to be displayed. 

 

Figure 19 – Column Selection menu 

 

1.5.4.2.2 Sort Rows 

 To sort display records by ascending or descending order: 

• Mouse over the header of the column. An arrow icon appears. 

• Click on the icon. 
 

 

Figure 20 – Sort 

 

1.5.4.2.3 Table Other Functionalities 

Common table elements for all windows tables are: 

Clicking once displays records by ascending order. 

Twice display records by descending order. 

Three times remove the sort. 



  

 

• Other options (tri-colon menu) 

 

1.5.4.2.3.1 Tri-colon menu (other options) 
Other table options are available through a tri-colon menu, on the right at the table level, that offers some options 
that will be applied to all the table. 

 

Figure 21 – Table Other Functionalities: Tri-colon menu. 

• Sort – Reset All menu: This option will reset all the sorts applied to the table. 

• Autosize: This option automatically adjusts all the columns width. 

• Print: This option allows the user to print a page. 

• Export (submenus CSV, Excel): This option allows the user to export all the data of the table in CSV or 
Excel format. 

• Reset to Default: This option resets all the filters, sorts, columns order…. 

 

1.5.4.2.3.2 Mini-table icon 

Other table options are available through mini-table icon, on the right of the table level. It offers the user he 
possibility to show/hide the columns and reorder them if needed. 

To open the columns list, the user shall click on the button shown in the screenshot below: 

Figure 22 – Table Other Functionalities: Mini Table icon. 

 

• Columns show or hide: The user can check/uncheck combo boxes to display/hide the columns. 



  

 

 
The user has the possibility to reorder the column by drag and drop the dotted square which is at the left of the 
column name as shown in the screenshot below: 

 

Figure 23 – Table Other Functionalities: Mini Table icon: Move/Hide button. 
 
 

 

1.6 Changing the Password 
• Go to Options (screw icon) > Password change 

• Enter the old password. 

• Enter a new password. 

• Re-enter the new password to confirm it. 

• Click the Change button. 

 

Figure 24 – Password Change Dialog. 

Password policy: 

• The password has a minimum of 9 characters. 

• The new password must be different to the last [24] passwords used. 

username



 

 

• Password must not contain the user's entire samAccountName (Account Name) value or entire 
displayName (Full Name) value. Both checks are not case sensitive: 

o The samAccountName is checked in its entirety only to determine whether it is part of the password. 
If the samAccountName is less than three characters long, this check is skipped. 

o The displayName is parsed for delimiters: commas, periods, dashes or hyphens, underscores, 
spaces, pound signs, and tabs. If any of these delimiters are found, the displayName is split and all 
parsed sections (tokens) are confirmed not to be included in the password. Tokens that are less than 
three characters in length are ignored, and substrings of the tokens are not checked. For example, the 
name "Erin M. Hagens" is split into three tokens: "Erin," "M," and "Hagens." Because the second token 
is only one character long, it is ignored. Therefore, this user could not have a password that included 
either "erin" or "hagens" as a substring anywhere in the password. 

• Password must contain characters from at least three of the following five categories: 

o Uppercase characters of European languages (A through Z, with diacritic marks, Greek and Cyrillic 
characters) 

o Lowercase characters of European languages (a through z, sharp-s, with diacritic marks, Greek and 
Cyrillic characters) 

o Base 10 digits (0 through 9) 

o Nonalphanumeric characters: ~!@#$%^&*_-+=`|\(){}[]:;"'<>,.?/ 

o Any Unicode character that is categorized as an alphabetic character but is not uppercase or 
lowercase. This includes Unicode characters from European languages. 

 

2. Participant Tasks 
ECAT software provides market participants with a set of web pages for direct entry and file upload of bids. 

When data are directly entered through the web page, the system carries out all necessary data validation and 
explicit error messages are sent back to the user in case of data rejection. 

When data are sent by a market participant through an XML file transfer, then an ENTSO-E acknowledgement 
document is sent back to the sender. 

The web interface of the ECAT product offers a set of functionalities to the Market participants allowing 
them to interact with the capacity auction process: 

• View the participant’s entitlements by corridors and horizons. 

• View auction specifications (Auction parameters, products, gates, maintenance periods). 

• Submit and review default bids. 

• Submit and review capacity bids: 

o Submit bids through the interactive user interface. 
o Import bids as an XML file using an ENTSO-E Bid document compliant with ECAN 

version 4 format. 

• View allocation results (awarded bids): 

o Display allocation results through the interactive user interface 

o Export allocation results by displaying or downloading the allocation results through an XML file. 
This XML file is an ENTSO-E Allocation Result document compliant with ECAN version 4 format 

o Export allocation results to a CSV file 

• Declare and review secondary market notifications: 



 

 

o Declare transfer notifications through the interactive user interface. 
o Import transfer notification XML file using an ECAN Rights document v4r0. 
o Confirm transfer notifications through the interactive user interface (Italian borders only). 
o Declare balancing reservation notifications through the interactive user interface. 
o Import balancing reservation notification XML file using an ECAN Rights document v4r0. 
o Display a list of approved transfers. 
o Declare resale notifications through the interactive user interface. 
o Import resale notification XML file using an ECAN Rights document v4r0. 
o Display a list of confirmed resales. 

• View Capacity right portfolios 

• Declare a change on ITR designation for a given auction: 
o Declare a change on ITR designation using the New ITR designation screen. 

• View the details of Programming Authorizations 

• Download files. 
 
 

 

2.1 Entitlements 
The entitlements of eCAT lets participants know on which auctions they could participate. 



 

 

The participants could read their entitlements from the UI menu: Entitlements -> Display. 

The table display the information below: 

• Corridor code: Unique code to identify the corridors and the direction (i.e: FR-BE is an auction 
from France to Belgium). 

• Horizon name: Horizon of the auction (e.g. Yearly, Monthly, Daily, Intraday, Shadow). 

• Is entitled?: Checkbox to identify the entitlements. 

• Effective day: The effective day to participate on the auction. 

• Termination day: The termination day to participate on the auction. 

 

Figure 25 – Entitlements screen. 
 
 

 

2.2 File Management 
The file management of eCAT lets participants manage many various files including bid files, secondary 
market notification documents. 

The capacity auction process relies on the reception and the transmission of several files. Participants can upload 
and download some of them. 



 

 

The list is displayed below: 

Table 4: Capacity auction files 
 

Tag Sender Receiver Format Document 

Bid for capacity CT JAO ECAN Bid Document 

Auction results (CT) JAO CT ECAN Allocation results 

Transfer Notification CT JAO ECAN Rights document 

Approved Transfer (CT) JAO CT ECAN Rights document 

Return Notification CT JAO ECAN Rights document 

Capacity Right Portfolio (CT) JAO CT ECAN Rights document 

Programming Authorizations (CT) JAO CT ECAN Rights document 

Day-ahead MIN AAC JAO CT ECAN Rights document 

Day-ahead MAX AAC JAO CT ECAN Rights document 

Balancing reservation Notification CT JAO ECAN Rights document 

 

2.2.1 File Upload 

 To upload a file (such as a Bid File): 

• Go to the menu File > Management. 

• In Tooltray click on Action pane. 

• Browse to the file on their local drive and, 

• Press Open once the file is selected. 
 

 

Figure 26 – File upload screen. 

File List pane displays information about the finished upload and its status: 

• Action: 2 icons are generally present. 

The files can be also drag and drop directly in Action pane. 



 

 

o First icon (  file open) can be clicked to open the document, that was submitted or issued, 
in a XML viewer. 

o Second icon (  download) let user save a copy of the file, that was submitted or issued, in its 
original format onto a local computer. The generated file is available in the browser download 
area. 

• Acknowledgement: 2 icons are generally present (see details in chapter 4.2.1.1 Acknowledgment) 

o First icon (  file open) can be clicked to open the acknowledgement file, that was received in 
response to the file submission, in a XML viewer. 

o Second icon (  download) let Participants save a copy of the acknowledgement file, that was 
received, in its original format onto a local computer. The generated file is available in the 
browser download area. 

• Registration Time: Date of log process. 

• Domain: Domain specified in the document (when present). 

• Market Period Start/Stop: Target period of the auction. 

• Horizon: Horizon of the auction (e.g. Yearly, Monthly, Daily, Intraday, Shadow). 

• Identification: Name of the file that was submitted or issued. 

• Version: Version of the submitted or issued file. 

• Document Type: The application automatically detects the type of document that was submitted. 

• Status: 

o Partially Accepted (Fully Accepted under reserve) in yellow if the declaration was partially 
accepted by the application. 

o Fully Accepted in green if the declaration was accepted by the application. 

o Fully Rejected in red if the declaration was not accepted by the application. 

• Related Document Identification: Identification of the acknowledgement file generated by the 
capacity auction system to external users (participants). 

• Related Document Version: Acknowledgment version. 

• Sender User: User. For example: user that uploads the document; user that generates the files… 
 

Figure 27 – File Management status 

 

2.2.1.1 Acknowledgment 

If the submitted file is rejected, operators can open the contents of the generated acknowledgement file to get 
some clues on the reason for the rejection. 

To do this the operator goes to Acknowledgment column and click on icon  (file open). 



 

 

 

 
Figure 28 – Example of Negative Acknowledgement file 

 

Figure 29 – Example of Partially Accepted Acknowledgement file 
 



 

 

 
Figure 30 – Example of Positive Acknowledgement file 

 
 

 

2.2.2 File Download 
Interface Management screen provides access to all documents available in the capacity auction system to which 
participants have legitimate rights: their bids, the allocation results, their secondary market notifications, their 
capacity right portfolios and the related acknowledgement files when applies. 

 To download a file (such as a Bid File): 

• Go to the menu File > Management. 

• In Tooltray, click on Filter pane: 

o Select the Document Type, Domain, Status, Horizon. 

o Select Start Date and Stop Date. 

▪ If Registration time is checked it will be the dates of a period that intersects with the day 
the searched files were submitted or generated. 

▪ If Market period is checked, it will be the dates of a period that intersects with the 
Market period of the searched files. 

• Click on the Refresh button. 
 

In File List, operators should use Action icons to see or download the file contents: 

• First icon (  file open) can be clicked to see the details of the file that was either submitted or 
issued or generated by the application. 



 

 

 

 

Figure 31 – Interface Management Document Viewer 

• Second icon (  download) let operators save the file that was submitted or issued or generated by 
the application onto the local computer. The generated file is available in the browser download 
area. 

 



 

 

4.2.1 Filters 
File Management screen provides filtering features. 

 To access the Auction Display screen:

• Go to Auction menu. 
 

 

Figure 33 – Auction Display Screen 

Participants can filter the auctions they want to display using the Filter pane. 

 To filter the listed auctions:

N.B.: Auctions cannot be modified by market participants. 



 

 

• In Filtering criteria, select: 

o Corridor (Multiple selections are allowed by clicking on Ctrl) 

o Auction state (Published, Pre-open, Open, Closed, Published results, Cancelled) (Multiple 
selections are allowed). At the first opening of the screen, the default selected values are “Pre-
open” and “Open”. If the user changes the selected values for auction state filter, then next opening 
of the screen will use these values. 

o Horizon (Multiple selections are not allowed) 

• Click on Refresh button. 

 
Auctions matching the search criteria are listed in the List pane with the following information: 

Table 6: Auction Information 

 

Column Description 

Action This column contains two icons: 

• New/Edit Bids: open the Bid matrix screen in edit mode in order to declare 
new Bids or to modify/cancel Bids on the selected auction. This icon is 
available only if the auction is Pre-open or Open. 

• View Bids: open the Bid matrix screen in read-only mode in order to display 
Bids for the selected auction. This icon is available whatever the auction 
state. 

Corridor The names of the border cross section for which the NTC-Based auctions auction is 
defined. 

Horizon The type of time horizon (Yearly, Monthly, Daily, Intraday). 

Market period start Delivery start 

Market period stop Delivery stop 

Auction identification(1) Identification of the auction : the reference for the bids to be submitted 

Current state Current state of the auction (Published, Pre-open, Open, Closed, Published results, 
Canceled) 

Nb of Bids If the auction is opened or pre-opened: number of valid (Fully Accepted) bids already 
submitted by the connected Trader on this auction 

 

Column Description 

Bid Time Left Display the remaining time before ‘Bid submission’ gate closure in case the auction is 
marked as open or pre-open. It is the remaining time for bidding before auction 
closure. 

By default, the auction list is sorted by increasing Bid time left. 

More information can be displayed on an auction once selected from the list and scrolling down to the Details 
pane. 

 When selecting an auction in List pane, Details pane is updated 

automatically. To improve readability, detailed information is organized in 

tabs.

The various tabs displayed are described below. 

 



 

 

2.2.3 Auction identification 
The “Auction identification” tab provides the same information as found in the list, along with a timetable 
summarizing the life cycle of the auction. 

 In this tab, all the identification information of the selected auction is displayed. 
 

Figure 34 – Auction identification 

• In Auction identification part 

o Auction identification: the reference needed for all the bids 
o Corridor 
o Market Period with the start/stop date 
o Horizon (Monthly, Daily…) 

• In Auction state there is the history of all the status of the auction with the state creation time. The last 
row in the list corresponds to the current state of the auction. 

 

2.2.4 Auction Parameters 
 In this tab, all the auction parameters information of the auction selected are displayed. All fields are read-only. 



 

 

 

 

Figure 35 – Auction Parameter 

 

• In Auction Type part, the information displayed are: 

o Auction Type: Sealed 

o Allocation mechanism: Merit Order 

• In Pricing parameters part: 

o Price measure unit (MWh) : configured for the corridor of the auction. 

o Pricing procedure: Uniform price. 

• In Transfer parameters part: 

o Transfer parameter Resale allowance tells if Resale is allowed from yearly auction to monthly auction. 

o Transfer parameter Transfer allowance tells if Transfer is allowed. It can only be done on yearly 
and monthly auctions. 

o Transfer parameter Resale rule tells if unused LT capacity is resold to daily auction (UIOSI principle) 

• In Capacity percentages (ATC percentage = 100%) 

• In Credit limit parameters part: 

o Credit limit checking parameter tells if financial guarantees are checked for the given auction. 

o Bid rejection at bidding time tells if bids can be rejected due to lack of credit limit. 

o Period to be secured. 

o X/N rule parameter is applied for long-term auction products with more than one month. 
 
 
 
 
 
 
 
 

 



 

 

2.2.5 Bidding Parameters 
 In this tab, all the bidding parameters information of the auction selected are displayed. All fields are read-only.



 

 

 

 

Figure 36 – Bidding Parameter 
 

• Define Bids & blocks: 

o Maximum number of bids the connected participant can submit for each corridor of the auction 

o Checked if Coupled bids are allowed. 

• Define Bid quantity 

o Maximum participant rate: 100% 

o Maximum quantity: MW 

o Bid quantity increment (the bid quantity must be a multiple of this quantity) 

• Define Bid price 

o Currency: Euro 

o Bid price increment. Bid price must be a multiple of this value. 
 

 

2.2.6 Auction Gates 
In eCAT, some processes are triggered at the opening or the closure of auction gates such as auction publication, 
auction clearing or auction results processing. 

 In this tab, all information about the various gates, linked to the selected auction, are displayed. All fields 
are read-only. 

 



 

 

Figure 37 – Auction Gate 

The Gate list is displayed with the following information: 

Table 7: Gate List 

 

Column Description 

Name Gate name 

Opening mode Automatic / Manual 

Opened Yes / No 

Open time Open date 

Format is “DD-MM-YYYY hh:mm”, local time. 

Closure mode Automatic / Manual 

Closed Yes / No 

Closure time Closure date 

Format is “DD-MM-YYYY hh:mm”, local time. 

Closure time max Closure date max 

Format is “DD-MM-YYYY hh:mm”, local time. 

 

2.2.7 Products 
 In this tab, all the Products information of the selected auction are displayed. All fields are read-only. 

 

Figure 38 – Products 
 

 

2.2.8 Allocation Constraints (NTC) 
 

Figure 39 – Allocation Constraints tab (NTC) 

 
The Allocation Constraints tab display the following information: 

 The tab Allocation Constraints displays information of the ATC released capacity and Offered Capacity 
(NTC) for NTC-based auction. 



 

 

Table 8: Allocation Constraints Information (case NTC-based auction) 

 

Column Description 

Technical Profile Name The related Corridor of the auction (e.g., FR-CH) 

Product identification The related product (e.g., BASE, Peak, Offpeak…) 

Product name The product name (e.g., Every day 00:00-24:00, Onpeak, Offpeak…) 

Offered Capacity (MW) The offered capacity 

Released Capacity The resold capacity 

ATC (MW) The available capacity 

2.2.9 Auction Results 
 Auction results tab must be visible only when auction results have been published: the current state 
of the auction must be “Published results”. 

This tab displays the main auction results of the current auction. So, one row in the list corresponds to a product. 
Only products corresponding to the current auction are displayed. 

 

Figure 40 – NTC-based Auction Results 

The Auction results list is displayed with the following information: 

Table 9: Auction Results Information (case NTC-based auction) 

 

Column Description 

Allocation Border Allocation Border on which capacity was offered 

Product identification Identification 

Product Name Name of the product 

Offered Capacity (MW) Offered Capacity (is expressed in MW). 

Requested capacity (MW) Requested Capacity (is expressed in MW). Sum of the bids (total demand) 

Allocated capacity (MW) Allocated capacity (is expressed in MW). Total allocated capacity for all 
participants. 

Auction price (EUR/MWh) Marginal price (is expressed in EUR/MWh): 

Equals to zero if demand is lowest than the offered capacity. Otherwise 
equals to the price of the last awarded bid. 

Shadow prices  

 
 

 

2.2.10 Comments 

A comment can be added by the system operator and viewed by the participant 



 

 

 

Figure 41 – Comments 



 

 

2.3 Bid Management 
ECAT provides the participant to display all bids whose bidder party corresponds to the party represented by 
the connected user. 

The submission of bids to the ECAT system by Market Participants can be done in two ways: 

• Entering the bids through the web interface on the “New/Edit Bids” screen. 

• Uploading a Bid document compliant with the ECAN specification, version 4r0. In this 
case an acknowledgment is sent back to the Capacity Trader. 

 
 

 

2.3.1 Bid States 
The life-cycle of a bid is controlled by a set of states as described in the UML activity diagram below: 

 

 

 
Figure 42 – Bid state diagram. 

The bid states are described below: 

 

 

 

  

 

 

  

 

   

 

 

 

 

 



 

 

Table 10: Bid States 

 

State name Description 

Created This is the initial state of a bid. 

This is a temporary state; this state is valid only during bid submission. At the end 
of the submission, bids are validated automatically by the Bid upload process, 
and they get into ‘Full accepted’, ‘Partially accepted’ or ‘Rejected’ state. 

Fully accepted A bid which has passed all the validation checks without any error: all time 
intervals (bid blocks) have been fully accepted. 

If a new version of this bid is submitted (modification), then the modified bid 
must pass the validation checks again, so the bid must get into ‘Created state’ 
again. 

If the bid is cancelled, then the bid get into ‘Cancelled’ state. 

Partially accepted A bid which has passed the validation checks with some errors on specific bid 
blocks: some bid blocks have been accepted whereas some bid blocks have been 
rejected; 

If a new version of this bid is submitted, then the modified bid must pass the 
validation checks again, so the bid must get into ‘Created state’ again. 

If the bid is cancelled, then the bid get into ‘Cancelled’ state. 

Fully rejected If a bid is submitted for the first time and if this bid is fully rejected, then such a 
bid will never be created in the system. If a new version of a valid Bid (fully 
accepted or partially accepted) is submitted, and if this new version is fully 
rejected by the validation checks, then this Bid shall move in ‘Fully rejected’ state. 
Such a bid can be resubmitted in a new version and pass the validation checks 
again, in this case the bid must get into ‘Created state’ again. 

Cancelled Fully accepted bids or partially accepted bids can be cancelled during the ‘Bid 
submission’ gate of the auction. This is a final state. 

Fully selected During the allocation of capacity (clearing phase), if all the bid blocks are fully 
selected by the allocation algorithm (all the requested capacity is fully selected), 
then the bid moves into a ‘Fully selected’ state. 

This is a final state. 

Partially selected During the allocation of capacity, if only a part (but not all) of the requested 
capacity is selected by the allocation algorithm (not all the requested capacity is 
selected), then the bid moves into a ‘Partially selected’ state. 

This is a final state. 

Unselected During the allocation of capacity, if for all the bid blocks no quantity is selected 
then the bid moves into an ‘Unselected’ state. This is a final state. 

 
 

 

2.3.2 Bid Submission Checks 
In order to be integrated by the eCAT system, bids must abide by the following rules: 

• Bids must be received before closure of the ‘Bid submission’ gate. 

• Participants must own an entitlement for the directed border and for the horizon of the auction. 



 

 

• A Bid document should contain all the Bids on one single auction. 

• If other users from the same company previously placed bids on corridors for which the user doesn’t 
have entitlements, the bid placed earlier should be present and unchanged in the submitted bid 
document (no creation/modification/deletion of bids for corridors without entitlements). 

• For a given corridor on an auction, participants cannot bid for more than the offered capacity. 

• For a given auction, participants cannot bid for more than the maximum participant rate which is a 
percentage of the offered capacity whose default value is defined in the bidding parameters of the 
auction and thus declared in the auction specification. 

• The number of Bids for each corridor of a defined auction must be lower than the Maximum number 
of Bids declared in the auction specification. 

• Bid price must be a multiple of the Bid Price Increment if any was defined in the auction specification. 

• Bid price must be equal or higher than the reserved price of the auction. 

• Bid quantity must be a multiple of the Bid Quantity Increment if any was defined in the 
auction specification. 

• The Bid currency must be Euro. 

• The unit of measurement for Bid price must be MWH. 

• Credit limit must be higher than total bid price, when Credit Limit checking parameter is enabled for 
the given auction (1) 

• The bid certificate for the bid signature must be the correct one 

 
During the Pre-Bidding gate, capacity traders may submit bids (pre-bids) but some checks will not be performed 
until the bidding gate opens: 

• Sum of bid quantities is not checked against Offered capacity as ATC may still change during the 
pre- bidding phase. 

• Financial guarantees are not checked (2) 

When the Bid Submission gate opens, above checks are performed on pre-bids along with all other checks already 
performed when they were submitted. Pre-bids will be rejected if they fail those validations. 

 
 

 

2.3.3 Credit Limit checking 
“Bank guarantees” – Registered Participant can provide JAO with a collateral in form of the bank guarantee. Bank 
Guarantees must be manually registered in the Auction system by JAO. 

“Deposits” - The capacity auction system gets periodic reporting from the Bank about the balance account (BA) of 
Trader’s business account. 

“Potential Liabilities” of a trader are determined as the sum of values of bids (based on the bid price) already 
submitted: 

 

1 See next section on credit limit checking. 
2 See next section on credit limit checking. 



 

 

• On monthly auctions whose clearing gate is not opened yet 

• On yearly auctions whose clearing gate is not opened yet 

o in this case liabilities may be set as 2/12 of the values of bids (based on the Bid price) already 
submitted. This happens only when there is no possibility to invoice potential capacities in 
advance (otherwise 1/12 is used). 

“Actual Liabilities” of a trader are determined as the sum of values of bids fully or partially selected (based on the 
Auction price) already submitted: 

• On monthly auctions whose Auction evaluation gate is closed 

• On yearly auctions on yearly auctions whose Auction evaluation gate is closed 

o in this case liabilities may be set as 2/12 of the values of bids (based on the Auction price) 
already submitted. This happens only when there is no possibility to invoice potential 
capacities in advance (otherwise 1/12 is used). 

“Credit Limit” is available amount of money that can be used by the trader for future bidding. Credit Limit is 
calculated as: 

Credit Limit = Bank Guarantees + Deposits – Actual Liabilities 

 
Some auctions may allow conditional acceptance of bids even when Credit Limit is not sufficient (liabilities of newly 
submitted bids are higher than Credit Limit). In such cases a warning with missing amount of money is issued in the 
acknowledgement file upon receipt of those new bids. The trader has an option to update value of bids, increase 
Deposits on bank account or increase Bank guarantees. If no action is done and Credit Limit is still not sufficient at 
the end of Bidding period (before the clearing is run) bids are rejected one by one starting with the one having the 
lowest price until Credit Limit is sufficient. 

 
 

 

2.3.4 New Bid Creation through UI 
When bids are directly entered through the web page, the system carries out all necessary data validation. 

Through the auction screen, participants can submit new bids for a selected auction. To do this, in Auction screen, 
the User has to select an auction in Auction list and then click on ‘New/Edit Bids’ button in column Action. 

Users can also create new bids through submenu ‘New/Edit bids’ in Bid menu. 



 

 

 

 

Figure 43 – New/Edit Bids submenu. 

 
The “New/Edit Bids” screen displays all the bids for a given auction on the same screen, as a matrix. 

In this way, the User can submit several Bids to a given auction at the same time and in a single step. 

The presentation differs according to the horizon of the auction: 

• Intraday/Daily auctions: bids are displayed in columns and products are displayed in rows by corridor. 

• Long-Term auctions: bids are displayed in rows and the corridor is displayed in column. 
 

Figure 44 – Yearly Bid Creation on a CEE Auction. 



 

 

 

 

Figure 45 – Bid Creation on Daily Auction. 

 To create a new bid

When the new bid is requested from the auction screen, the auction parameters and the auction ID are 
automatically displayed. 

• The first set of fields available in the screen act as filters to narrow the list of selectable auctions. 

o Select a Corridor 

o Select a Horizon 

o Select a Market Period (Auction delivery period) 

▪ For Daily Horizon: select a Day in DD-MM-YYYY format, for example: 24-04-2023. 

▪ For Monthly Horizon: select a Year (for example: 2023) and a Month (for example: May) 

▪ For Yearly Horizon: select a Year (for example: 2023) 

o Choose Auction identification among the drop-down list. 

The listed auctions are all auctions defined for the selected horizon, market period and corridor, 
with a ‘Pre-Open’ or ‘Open’ status. 

• Credit Limit are summarized in the top section of the screen. 

• In the Bid list part, the system displays a Bid matrix: 

o Daily Auctions: One empty Bid is displayed with 1 column for Bid Qty and 1 column for Bid 
Price. The products sold on the selected auction are displayed in rows. The system also 
displays the Offered capacity, the total bid quantity per hour, and the total Offered capacity 
over all the hours. To add a new bid, click on the “+” button situated in the upper right corner, 
next to the bid identification. The user will be notified when he has reached the limit of bids. 



 

 

 

 

Figure 46 – Add new daily bid. 

 
o LT Auctions: N empty Bids are displayed in rows with 1 column for Bid Price and 1 column for 

Bid Qty where N is the maximum number of Bids. The system also displays the Offered 
capacity and the total bided quantity. 

 

Figure 47 – Add new LT bid. 



 

 

 
The participant must enter Bid quantity and Bid Price for each product sold on the selected auction. 
Besides, the Participant may enter several Bids at the same time through this Bid Matrix screen. 

o For daily auction, there will be 24 hourly products to specify. If no bid is to be declared on a 
given hour, leave a 0 for both quantity and price. 

 
The system automatically generates the corresponding ECAN Bid file and internally uploads it into the system. 

• A page is displayed allowing submitting participants to follow the current processing (same as for any 
file upload), and its result. 

 

Figure 48 – New Bid: Status of the creation. 

 
Clicking on the cross brings back to “New/Edit Bids” creation screen with the same Horizon, Market Period, 
Corridor and Auction ID filters as in the previous display. 

 
 

 

 To view a new bid document:

• Once the process is complete, go to File -> Management 

o Select Bid as document type 

o Enter the start/stop date corresponding to the time the bid was created (registration time 
checked) or the start/stop date corresponding to the market period of the associated auction 
(Market period checked). 

o The document list displays the bid document submitted to the system. 



 

 

 

 

Figure 49 – View list Bid document. 

 

• Select your new bid document. 

• Click on open icon in Action column. The XML will be displayed in a viewer. 
 

 



 

 

Figure 50 – View the Bid document. 

 

 To download a new bid document:

• Select your new bid document. 

• Click on save icon in Action column 

 
 To see the new bid document acknowledgment:

• Select your new bid document. 

• Click on open icon in Acknowledgement column. The XML will be displayed in a viewer. 



 

 

 

 

Figure 51 – New Bid: View acknowledgement of new Bid document. 
 
 

 

2.3.5 New Bid creation through File Upload 
The procedure to upload a bid file into the capacity auction system is the generic procedure to upload a file into the 
capacity auction system. It is done from the File Upload screen. 

The parsing follow-up and the review of acknowledgement can be done with File Download screen. Please refer to 
preliminary sections to get the detailed instructions on how to upload a file, check the acknowledgement status and 
review the details of acknowledgement. 

For a given auction, all the Bids have to be submitted within the same ECAN Bid document. 

If the Trader wants to modify or cancel one or several Bid(s) for this given auction, he will have to submit a new 
ECAN Bid document with the same document ID and an incremented document version. 

 
 

 

2.3.6 Copy/paste from Excel 
The system offers the possibility to copy Bids from an Excel sheet and paste them to the “New/Edit Bids” screen. 

 To copy/paste Bids from Excel: 

• Enter the “New/Edit Bids” screen (from Auction screen or Bid screen) 

• Download the Excel template for the bids and create the bids 

• In the Excel sheet, select the data grid content to be copied. 

• Copy the selected content to the clipboard (Press CTRL-C on the keyboard or make a right click and 
select Copy in the contextual menu) 

• Go back to the “New/Edit Bids” screen and Press CTRL-V to paste the selected content from the 
clipboard. 

Note that the System performs some basic validation checks: 



 

 

• LT auctions: 

o Rows number should be equal or less than the maximal number of Bids. 

o Columns number should be a multiple of 2. 

o The header of the bid must be the corridor for which the bids are created and will 
occupy 2 columns, corresponding to the quantity and the price. 

o Quantity and Price must be numbers. 

o If the Price contains decimals the separator must be “.” 

• Daily auctions: 

o Rows number should be equal to the number of hours within the delivery day of the auction 
(23, 24 or 25). 

o Columns number should be a multiple of 2. 

o Columns number should be equal or less than the 2*N where N is the maximal number of Bids. 

o The header of the bid must be the corridor for which the bids are created and will 
occupy 2 columns, corresponding to the quantity and the price. 

o Quantity and Price must be numbers. 

o If the Price contains decimals the separator must be “.” 
 
 

 

2.3.7 View bid screen 

Through the auction screen, participants can view in the same screen in read-only mode all the bids that have been 
submitted to the selected auction. 

To do this, in Auction screen, the User must select an auction from the Auction list and then click on ‘View Bids’ 
button in column Action. 

The “View Bids” screen displays all the bids for a given auction on the same screen in read-only mode, as a matrix. 

The user could also access to the “View Bids” screen through the menu Bid -->View Bids. 

 When the “View Bids” screen is accessed from the auction screen, the filtering criteria are automatically filled. 

In the Bid list part, the system displays a Bid matrix: 

• Daily Auctions: Bids are displayed in columns with 1 column for Bid Price and 1 column for Bid Qty. 
The products sold on the selected auction are displayed in rows. The system also displays the Offered 
capacity, the total bided quantity per hour, the total Offered capacity over all the hours and the total 
bided quantity over all the hours. 

• LT Auctions: Bids are displayed in rows with 1 column for Bid Price and 1 column for Bid Qty. The 
system displays also the Offered capacity and the total bided quantity. 

 

2.3.8 Bid List 
With the Bid display, participants have access to all bids they have submitted. 

To display a bid list, select the Bids submenu in Bid menu, enter filtering criteria and press the refresh button. 



 

 

 

 

Figure 52 – Bid list display (LT auctions). 
 

Figure 53 – Bid list display (Daily auctions). 



 

 

 
 

 
After displaying the Bid Management view, the displayed bids can be filtered using a set of Filter properties. 

 To filter the bids to be displayed: 

• In Filtering criteria select 

o Corridor (Multiple selections are allowed) 

o Bid state (Created, Fully accepted, Partially accepted, Fully rejected, Cancelled, Fully 
selected, Partially selected, Unselected) (Multiple selections are allowed) 

o Version (Multiple selections are allowed) 

o Horizon (Multiple selections are not allowed) 

• Click on Refresh button. 

A row in the list represents one bid. 
 

 
The result of the bid filtering is displayed in the table with the following information: 

Table 11: Bid List Information 

 

Column Description 

Auction identification Unique identification of the auction to which the bid is addressed 

Corridor The name of the oriented border corridor for which the auction is defined. 

TSO Border TSO Border 

Bid Identification The identification assigned by the sender that uniquely identifies the bid. 

Version 1 Version of the bid. All the versions of a bid can be displayed, but only the latest 
version of a bid is taken into account in the process of auction clearing 

Current state Current state of the selected bid 

Divisible An indication whether or not each element of the bid may be partially accepted 
or not. A yes indicates it can be partially accepted. 

By default, this parameter is set to Yes. 

Block Bid Is it a Block Bid? Yes/No 

Product Product associated to a selected auction and one bid block 

Qty (MW) Bid Quantity 

 

1 N.B.: A new version of a bid is created if the operator performs a modification of an existing bid. A new row 
appears in the Bid table if the filtering criteria specify the selection of all versions of bids. 



 

 

 

Column Description 

Price Bid Price 

Price measure unit Price measure unit (EUR/MWh) 

Action Open: Edit the selected Bid document in a XML viewer. 

The XML Bid document corresponds to the version of the document for the 
selected Bid identification. 

Save : Download the selected document in its original format in a local directory 

 
Users can select a bid in the list. The screen provides detailed information about the selected bid if any. 

 To see the details of a bid: 

• Select the bid 

• The detail part is automatically 

updated. The various tabs displayed are 

described below. 

 

 

2.3.8.1 Bid identification 

 In this tab, all the identification information of the bid selected is displayed (all the fields are read-only). 

• In Bid identification part 

o Bid identification. 

o Corridor 

o Market Period with the start/stop date. 

o Auction identification to which the bid is addressed. 

• In Version part 

o The version of the selected bid 

o If it is the last version 

o The creation time. 

o The creation user. 

• In Bid states there is the history of all the status of the bid with the state creation date and the 
state creation user. The last row in the list corresponds to the current state of the bid. 

• In Parties 

o Bidder name: name of the submitter. 

o Subject party: name of the Capacity Trader. 



 

 

 

 

Figure 54 – Bid identification. 
 
 

 

2.3.8.2 Bid blocks 

 In this tab, all the bid details are displayed: quantity, price… for each product (All the fields are read-only). 
 

Figure 55 – Bid Blocks. 

 
The bid details list displays the following information: 

Table 12: Bid Block Information 

 

Column Description 

Product identification Identification of the product to which the bid is addressed 

Product name Name of the product 

Bid quantity Bid quantity (is expressed in MW) 

Bid price Bid price (is expressed in EUR/MWh) 

Awarded quantity Awarded quantity (Is expressed in MW). 

Visible only when auction results have been published 

Awarded price Awarded price (Is expressed in EUR/MWh). 

Visible only when auction results have been published 



 

 

2.3.8.3 Bid Parameters 

 In this tab, all the bid parameter information are displayed (all the fields are read-only). 
 

Figure 56 – Bid Parameters. 

 

2.3.9 Bid Modification 
There are 3 ways to modify bids: 

• By submitting of a new version of the original Bid document with an update for the Bid being modified. 

 Submit the same bid document after having updated it with the relevant bid quantity and price and 
increased the document version by 1 including all bids already contained in the old version of the 
document.

• By modification through the UI. 

 To modify a bid through the UI from Auction menu:

o Select in List the auction associated to the bid to be modified. 

▪ In column Action, click on New/Edit Bids button. 

▪ An Edit Bid screen is displayed with all the Bid information preset. 

▪ Change Bid quantity and/or Bid price. 

▪ Note that if you click the Reset to current bid values button, then all your changes are 
cancelled, and the bid matrix is restored with the values of Bids currently saved in the 
database. 

▪ Once all information is filled in, click on the ‘Save’ button to finish the creation of the 
new Bids and submit it to the capacity auction system. 

▪ A new Bid XML file is generated. 

Or 

 To modify a bid through the UI from Bid tab - >  New/edit Bid:

o An Edit Bid screen is displayed with all the Bid information preset. 

o Change Bid quantity and/or Bid price 



 

 

o Note that if you click the Reset to current bid values button, then all your changes are 
cancelled, and the bid matrix is restored with the values of Bids currently saved in the 
database 

o Once all information is filled in, click on the ‘Save’ button to finish the creation of the new Bids 
and submit it to the capacity auction system. 

o A new Bid XML file is generated. 

 

Figure 57 – Edit Bid. 

 

2.3.10 Bid Cancellation 
There are 2 ways to cancel bids: 

• By submitting a new version of the Bid document not including the Time Series of the Bids to be deleted. 

 Submit the same bid document after having removed the relevant bid time series and incremented 
the document version by 1. 

• By a cancel through the UI. 

 

 To cancel a bid through the UI: 

• Go to Auction menu. 

• Select in List the auction associated to the bid to be cancelled. 

o In column Action, click on New/Edit Bids button. 

o An Edit Bid screen is displayed with all the Bid information preset. 



 

 

o Click the Clear Bid button linked to the bid you want to cancel. You can also click the Clear 
All Bids button if you want to cancel all the Bids on the selected auction. 

o Note that if you click the Reset to current bid values button, then all your changes are 
cancelled, and the bid matrix is restored with the values of Bids currently saved in the 
database 

o Once all information is filled in, click on the ‘Save’ button to finish the creation of the new 
Bids and submit it to the capacity auction system. 

o Once the cancellation is confirmed the bid status changes to ‘Cancelled’ and a new Bid 
XML file is generated. 

 

 

 

Figure 58 – New/Edit Bids menu. 
 

 

Note that you can also access to the Edit Bid screen by clicking on “New/Edit Bids” in the Bid tab. 

IMPORTANT NOTE: For daily auctions the New/Edit Bids button leads to actions on one single bid time 
series corresponding to 24 hours of bids. 

Consequently, to cancel a single hourly Bid via UI, participants should consider bringing up the Edit screen 
and put a 0 for quantity and price for the desired hour. 



 

 

2.4 Default bids 
ECAT provides the participant the possibility to define default bids. The default bids could be 

defined: 

• For each corridor, 

• For each horizon (Intraday, daily, monthly, yearly …), 

• For each auction type (shadow, base, peak …). 
 
 

 

2.4.1 Default Bid submission checks 
ECAT provides the participant to display all default bids whose bidder party corresponds to the party 
represented by the connected user. 

The submission of default bids to eCat system by Market Participants can be done through the web interface 
through the “New/Edit Default bids” screen. 

 
To be integrated by the eCat system, bids must abide by the following rules: 

• Price is mandatory. 

• Quantity is mandatory. 

• Quantity and Price must be numbers. 

• Positions on all the hourly intervals are required. 

• Default bid prices must be a multiple of 0.01Eur. 

• Default bid quantities must not have decimals. 

• The Default bid currency must be Euro. 

• The unit of measurement for Default bid price must be MWH. 

• Traders are not allowed to change default Bids while the corresponding auction is currently running. 
An explicit error message is displayed if a Trader tries to change default Bids while there is a lock on 
default bids for the given corridor. 

• A Trader can participate in a shadow auction only if he holds an entitlement on the corridor for daily 
auctions. 

• Credit limit is checked for shadow auction at default bidding gate closure (warning only), pre-bidding 
gate closure if it exists (warning only) and bidding gate closure (rejection of bids until CL is satisfied).  



 

 

2.4.2 Default Bids exceeding OC 
When the total bided quantity exceeds OC of the auction, Bids will be created from default Bids according to a 
priority order: 

• Priority order is implicitly given by the bids price: Bids with the highest price have the highest priority, 
bids with the lowest price have the lowest priority. (1) 

• Bids are created one by one from default Bids by following the priority order and until total bided 
quantity exceeds OC of the auction. 

• Bid quantity of the last bid that exceeds OC is not used so that total bided quantity is not over the OC. 

• Remaining default Bids within the priority order do not lead to creation of Bids. 
 
 

 

2.4.3 New default Bid Creation 
Users can create new default bids through submenu ‘New/Edit Default bids’ in Bid menu. 

 

Figure 59 – New/Edit Default bids submenu 

 
The “New/Edit Default bids” screen displays all the default bids for a given corridor on the same screen, as a 
matrix. 

In this way, the User can submit several Default bids to a given corridor at the same time and in a single step. 
 
 
 
 
 
 
 
 
 
 

 

1 For daily auctions, the priority order is implicitly given by the bids values: Bids with the highest value have the 
highest priority, bids with the lowest value the lowest priority. (Bid value = sum of quantity by price for all the 
positions of the same bid) 



 

 

 

 

Figure 60 – Default Bid Creation screen 

 
 To create a new default bid 

• Select a Corridor 

• Select a Market in Market Selection 

• In the default Bid list part, the system displays a Default Bid matrix: 

The participant has to enter a Quantity and a Price for each hour of the day (including the missing hour and 
the repeated hour for clock change). Besides, the Participant may enter several Default Bids at the same 
time through this Default Bid Matrix screen. 

There are 25 hourly products to specify. If no default bid is to be declared on a given hour, leave a 0 for 
both quantity and price. 

• Once all information is filled in, click on the ‘Save’ button to finish the creation of the new default Bids 
and submit it to the capacity auction system. 

• A page is displayed allowing submitting participants to follow the current processing, and its result. 



 

 

 

 

Figure 61 –Daily market selection on AT-CH 
 

Figure 62 – Yearly market selection on CEE 

 

Figure 63 – Creation’s status of Default Bid 

 
Clicking on the cross brings back to “New/Edit Default Bids” creation screen with the same Horizon, Market Period, 
Corridor and Auction ID filters as in the previous display. 



 

 

2.4.4 Copy/paste from Excel 
The system offers the possibility to copy Default Bids from an Excel sheet and paste them to the “New/Edit Default 
bids” screen. 

 To copy/paste Default bids from Excel: 

• Enter the “New/Edit Default bids” screen (through “New/Edit Default bids” submenu) 

• Select a corridor. 

• Select an Auction type. 

• In the Excel sheet, select the data grid content to be copied. 

• Copy the selected content to the clipboard (Press CTRL-C on the keyboard or make a right click and 
select Copy in the contextual menu). 

• Go back to the “New/Edit Default bids” screen and Press CTRL-V in order to paste the selected 
content from the clipboard. 

 

 

 

 
2.4.5 Default Bid Modification 

 To modify a Default bid through the UI: 

• Enter the “New/Edit Default bids” screen (through “New/Edit Default bids” submenu). 

• Select a corridor. 

• Select an Auction type. 

o An Edit Default Bid screen is displayed with all the Default Bids that have been 
previously entered. 

o Change the Quantity and/or the Price. 

o Note that if you click the Reset to current default bid values button, then all your changes are 
cancelled, and the default bid matrix is restored with the values of Default Bids currently saved 
in the database. 

o Click the Save button. 

Note that the System performs some basic validation 
checks: 
• 

• 

• 

• 

Rows number should be equal to 25. 

Columns number should be a multiple of 2. 

Columns number should be equal or less than the 2*N where N is the maximal number of 

The header of the bid must be the corridor for which the bids are created and will occupy 2 
columns, 

• 

• 

Quantity and Price must be 
numbers. 
If the Price contains decimals the separator must be 
“.” 



 

 

 

 

Figure 64 – Edit Default Bids 

 

2.4.6 Default Bid Cancellation 

 To cancel a Default bid through the UI: 

• Enter the “New/Edit Default bids” screen (through “New/Edit Default bids” submenu). 

• Select a corridor. 

o An Edit Default Bid screen is displayed with all the Default Bids that have been 
previously entered. 

o Click the Clear Default Bid button linked to the Default bid you want to cancel. You can also 
click the Clear all Default Bids button if you want to cancel all the Default Bids on the selected 
corridor. 

o Note that if you click the Reset to current default bid values button, then all your changes are 
cancelled, and the default bid matrix is restored with the values of default Bids currently saved 
in the database. 

o Click the Save (filtered) button. 
 

IMPORTANT NOTE: to cancel a single hourly Default Bid via UI, participants should consider bringing up 
the Edit screen and put a 0 for quantity and price for the desired hour. 



 

 

2.4.7 Surrogate Default bidding 
In case Participants do not have access to the GUI, they may ask JAO operators to submit, modify or cancel Default 
bids on their behalf. As a matter of fact, JAO operators have an interface which grants them the ability to manually 
submit default bids and cancel default bids. 

Note that JAO operators have no interface to manually modify Default bids as they cannot see the price and the 
quantity of the default bids. Consequently, the way JAO operators actually manually modify a Default bid on behalf 
of Capacity traders is through the cancellation of the previous Default bid and the submission of a new Default bid 
with the modified characteristics. 

In their request, Participants should communicate detailed Default bid characteristics to JAO, so that JAO operators 
are able to perform manual default bid submission on their behalf. 

Once Participants get back their access to the GUI, they can check that the Default bids have been properly treated 
by JAO operators in the Default Bid display. 



 

 

2.5 Shadow auctions 
Shadow auctions correspond to fallback for daily implicit (Market Coupling) and explicit auctions. 

 

2.5.1 Business process overview 
Business process sequence is summarized as below: 

• Traders submit default Bids to eCat by giving default hourly qty/price values for a given oriented border. 

• Shadow auctions are visible on JAO website only when Fallback is triggered. 

• Shadow auctions can be easily differentiated from other auctions thanks to their auction ID which contain 
“SHADOW” substring. 

• TSOs send ATC with auction ID of a shadow auction to eCat. 

• ATC is published on JAO website only when Fallback is triggered. 

• If TSO don’t confirm the shadow auction operation to JAO, then no capacity is allocated on the shadow 
auction for the given day. 

• In the event of a shadow auction, JAO Operator activates manually the auction. The System 
automatically imports from the database the set of default Bids at opening of Bid submission gate 
and run the clearing. 

• The shadow auction is cleared by the same Merit order algorithm as for clearing of LT Explicit 
auctions. Check of credit limit is done at the end of bidding gate. 

• In case of NL-NO and DE-D2 border, a ramping constraint has to be taken into account. 

• Allocation results of the shadow auction are published on JAO website. 

• Allocation results are sent to TSOs, and Traders. 

• Programming authorizations are processed by the System and sent to TSOs and Market participants 
in the same way as in the explicit auction process. 

• Settlement and invoicing is run in same way as in the explicit auction process: shadow 
auctions are invoiced on M+1. 

• When UIOSI of LT Capacity is settled at the marginal price, then the marginal price of the shadow 
auction is used when a shadow auction is triggered. 

 

2.5.2 Shadow/Default bids overview 

With the Shadow/Default bids overview, participants have access to all Shadow/Default bids they have submitted. 

The participant user has the possibility to display shadow/default bids overview list that respects a given filtering 
criterion. To do so, the user shall follow the steps below: 

• From the left side panel 

o Select a Corridor from the dropdown list (Multiple selections are allowed) 

o Select a Market (Multiple selections are not allowed) [This field is automatically 
updated to display the markets linked to the selected corridor(s) 

• Click on Refresh button. 



 

 

 

 

Figure 65 – Shadow/Default Bid list display. 

 
The result of the bid filtering is displayed in the table with the following information: 

Table 13: Shadow/Default Bid List Information 

 

Column Description 

Action This column contains two icons: 

• Edit/View default Bids: open the Default Bid matrix screen in edit mode in 
order to declare new Default Bids or to modify/cancel Default Bids on the 
selected market. 

Corridor The name of the oriented border corridor for which the auction is defined. 

Market name The name of the market 

Number of shadow/default 
bids 

Display the number of shadow/default bids 

Last modification time Time of the last modification of the bids 

 

Under action column, the click on the button ‘Edit/View default bids’ redirect the user to the default bid screen in 
order to view or even update the existing default bid 

 

2.6 Allocation result 
 The ‘Auction evaluation’ gate begins immediately after the ‘Bid submission’ gate closure. 

 At the opening of ‘Auction evaluation’ gate, the System launches a clearing to compute the auction results. 

 
The allocated results process is the following: 

• Process of auction results: run of the bid selection process and determination of the awarded bids 
and the marginal price. It is broken into following steps: 

o Bid selection process: 

▪ Execution of the clearing algorithm. 

▪ Determination of the awarded bids and the auction prices. 

▪ Bid state management: process of the bid selection status. 

o Generation of an event log ‘Auction results have been processed’. 



 

 

The following data flow diagram shows the input data and the output data associated to this bid selection process: 
 

Bids 

Auction 

Awarded Bids 

Auction price 

Requested capacity. 

Allocated capacity 

 

Figure 66 – Input/output Data Diagram 
 

 
For each product (auction block) that is sold on the auction, the bid selection process allocates the Offered capacity 
of this product to the market participants by determining following output data: 

• Awarded quantity and awarded price for each Bid Block that has been submitted on the given product. 

• Auction price 

• Total requested capacity: sum of Bid Block quantities 

• Total allocated capacity: part of the Offered capacity that has been sold. 
 

 
The system switches the state of each Bid of the system that has been submitted on the given auction (consider only 
the latest version of the Bids) in one of the following states: 

Table 14: Bid State after Allocation Result 

 

State name Description 

Fully selected During the allocation of capacity, if all the bid blocks (time intervals) are fully selected by 
the allocation algorithm (all the requested capacity is fully selected), then the bid moves 
into a ‘Fully selected’ state. 

This is a final state. 

Partially selected During the allocation of capacity, if only a part (but not all) of the requested capacity is 
selected by the allocation algorithm (not all the requested capacity is selected), then the 
bid moves into a ‘Partially selected’ state. 

This is a final state. 

Unselected During the allocation of capacity, if for all the bid blocks no quantity is selected then the 
bid moves into an ‘Unselected’ state. 

This is a final state. 

 

It is possible that some bids are not considered by the allocation algorithm due to insufficient Credit Limit – 
see Credit Limit checking. 

Publication of auction results: results are made available to the participants in the web interface. ECAN Allocation 
Result documents are generated and made available to the participants in the file download interface. Furthermore, 
auction results are generated and published on ENTSO-E Transparency Platform. 

Allocation result display: The allocation results are displayed in the user interface. Allocation results correspond to 
the detailed results of the bid selection process, they provide the awarded quantity and the awarded price for each 
bid block that has been submitted on the given auction. 

 

Bid selection process. 



 

 

2.6.1 Allocation Result Control 
Once the auctions results processing is ended, output data can be checked in several ways through the Participant 
UI: 

 To check auction results: 

1) In the Auction display: 

• Go to Auction menu. 

• Apply the filters to see the auction. 

• In the Auction results tab, check the allocation results. 

• This tab displays the main auction results for the selected product which had been put on sale. 
 

Figure 67 – Auction Screen after monthly auction clearing. 

 
2) In the Bid List display: 

• Go to Bid -> Bids. 

• If not selected by default, filter to see the bids. 

• In the Bid blocks tab, following fields are displayed. 

o Awarded quantity. 

o Awarded price. 
 

Figure 68 – Bid Block Screen after clearing 1. 

• The Bid could have different states (Fully selected, partially selected, Unselected, Cancelled). 
The participants can check these states in the menus below: 

o Current state: The current state of the bid is displayed in the list of bids (column Current state). 

o Bid identification tab: all bid states are displayed in the bid state list. 



 

 

 

 

Figure 69 – Bid List Screen after clearing 2. 

 
3) In the Allocation results menu: 

• Go to the menu Capacity right -> Allocation results 

After displayed the Allocation results Management view, the displayed allocation results can be filtered 
using a set of Filter properties. 

 To filter the allocation results: 

o In Filtering criteria, you could select: 

▪ Corridor 

▪ Horizon 

▪ Select a Market Period (Auction delivery period) 

✓ For Daily Horizon: select a Day in DD-MM-YYYY format, for example: 29-
04- 2023 

✓ For Monthly Horizon: select a Year (for example: 2023) and a Month 
(for example: May) 

✓ For Yearly Horizon: select a Year (for example: 2023) 

▪ Auction identification: Select the auction identification from drop down list. 

o Click on Refresh button. 

The result of the allocation results filtering is displayed. 

The presentation differs according to the horizon of the auction: 

• Daily auctions: allocation results are displayed in columns and products are displayed in rows. 



 

 

• Long-Term auctions: allocation results are displayed in rows and products are displayed in columns. 

Long-term auctions: 

The list presents the results on a bid-by-bid basis. 

A row in the list represents one Bid and it gives the allocation results for this Bid: 

• Awarded quantity (MW) 

• Clearing price (EUR/MWH) 

• Bid quantity (MW) 

• Bid price (EUR/MWH) 

 
Total awarded quantity (MW) and total bided quantity (MW) are displayed in the first row, just under the headers. 

 

Figure 70 – Allocation results of long-term auctions. 

Daily auctions: 

The 4 first columns of the list represent following information, for each hour of the day: 

• Hourly product (Delivery hour) 

• Total awarded quantity (MW), 

• Clearing price (EUR/MWH) 

• Offered capacity (MW). 



 

 

 

 

Figure 71 – Allocation results of Daily auctions 

 
The list presents the results on a bid-by-bid basis. 

A group of 3 columns in the list represents one Bid and it gives the allocation results for this Bid and for each hour 
of the day: 

• Bid quantity (MW) 

• Bid price (EUR/MWH) 

• Awarded quantity (MW). 

Total awarded quantity (MW) and average auction price (EUR/MWh) are displayed in the last row, as summary 
information. 

If an auction is cancelled after the result publication, the allocated capacity values are changed to 0 by the eCAT 
system. 

Allocation results can be exported to a convenient CSV file by clicking the Export results to CSV button. 



 

 

2.7 Secondary Market 

2.7.1 Transfer of capacity rights 
Any market participant can sell part or all their awarded capacity rights to another market participant. 

The transfer must be declared to the capacity auction system through a Transfer Notification. This operation could 
be done either through the file upload of a Transfer Notification ECAN Rights document v4r0 document or using the 
New Transfer screen in the GUI. 

If the transfer notification passes all business validation checks, then the transfer is recorded in the database, a 
positive acknowledgement is sent back to the transferor and the rights portfolio of the transferor is updated. 

Transfer notifications have to be manually confirmed by the Transferee within 4 hours, but not later than Transfer 
deadline. If transfer is not approved within 4 hours, then the transfer notification is automatically cancelled by the 
System. When waiting for the transfer approval, the transfer notification is pending, and the transferor can cancel 
the transfer. 

As soon as a transfer notification is confirmed, the rights portfolio of the Beneficiary of the transfer is updated and 
the System sends to both transferor and transferee a Notification of approved transfer in the form of an ECAN 
Rights document v4r0. These notifications of approved transfer are available for download in the File download 
screen. 

The transfer confirmation is sent by mail as an attachment to the Transferor and the Transferee within 30 minutes 
after the reception of the transfer notification. 

In case of transfer rejection, the system generates only an acknowledgement with a negative status and reason for 
rejection to the transferor. No message is sent to the transferee. 

Note: The financial transaction between participants for transfers of capacity rights is not managed by the capacity 
auction system. 

 

2.7.1.1 Transfer Notification submission rules 

In order to be properly integrated by the system, transfer notifications must follow some rules: 

• Transfer notifications including transfers on market day D must be received before closure of the ‘LT 
Transfer’ gate, that gate closing every day at a configurable time (depending on the domain) before the 
sending of LT programming authorizations to TSOs. 

• Transferor must be the owner of the capacity to be transferred. 

• Transferor and transferee must correspond to registered Capacity traders that are valid over all the 
transfer period. 

• Transferee must hold an entitlement for the directed border (whatever the horizon) on which the 
transfer takes place. 

• Market participants have the option to pay the full or part of the product price (i.e. all or several monthly 
instalments at once) and the Operator must unblock the transfer limitation by marking the paid 
months, allowing the market participant to transfer the paid part of product. Only the part of the 
capacity which is guaranteed by financial risk instruments can be transferred (transfer is able to be 
made only for the 1 coming month for capacity with delivery period over one month). 

• Transfer period can be on one or several days. 

• The minimum resolution of the transfer is 1 MW over 1 hour. 

Type text here



 

 

• There is no versioning of transfer notifications. 

• To cancel a transfer, the transferee should declare a reverse transfer. 
 
 

 

2.7.1.2 New Transfer Notification through GUI 

Users can declare a new transfer notification through submenu ‘New transfer notification’ in Secondary market 
menu. 

 

Figure 72 – New transfer notification menu. 
 

 

 To declare a new transfer notification: 

• Find the auction by filtering the parameters below: 

o type: Select Transfer from drop down menu. 

o corridor: Select the corridor. 

o horizon: Select the horizon of the auction from the drop-down menu. 

o transfer period start: Select the transfer period start from calendar icon. 

o transfer period end: Select the transfer period start from calendar icon. 

• Click on Refresh button. The participant can now select the related auction. 

o Auction identification: select the auction from drop down list where the rights to be 
transferred were acquired. 

o Transferee: the identification of the “transferee” party. 

o Days (All days, by default): subset of days within the transfer period on which the transfer 
should be applied (All days, working days, Saturday and Sunday, Working days and Saturday, 
or Sunday). 

o Exclude maintenance periods (disabled by default): by enabling this checkbox, the Transferor 
declares that he wants to exclude maintenance periods with ATC=0 when processing the 
transfer. 

• In the Transfer Notification schedule part, specify the quantity to be transferred out of the available 
transferable capacity for each hour of the day. This daily schedule will be applied for all days of the 
transfer period. 

Note that if participants cannot access to the GUI, they may use the surrogate secondary market mode 
and contact JAO operators to launch downgraded mode. 



 

 

o As a shortcut to quickly fill up the 24 hours of the daily schedule, users can specify a 
percentage of the available transferable capacity and press the “Set for whole period” 
button 

o In order to quickly fill up the schedule, set the quantity of the first hour and press the V button 
on the right side of a given hour. It will fill the quantity boxes to all following hours. 

 

Figure 73 – New Transfer Notification screen. 

 
The submission of the transfer notification to the explicit auction system is immediate as soon as the ‘Save’ button 
is pressed. 

 

2.7.1.3 New transfer notification through File Upload 

The procedure to upload a transfer notification file into the capacity auction system is the generic procedure to 
upload a file into the capacity auction system. 

It is done from the File Upload screen. The parsing follow-up and the review of acknowledgement can be done with 
either Event log or File Download screen. Please refer to preliminary sections to get the detailed instructions on how 
to upload a file, check the acknowledgement status and review the details of acknowledgement. 

 

2.7.1.4 Transfer notification control 

With the Transfer Notification display, participants have access to all transfer notifications they have submitted or 
for which they are the transferee. 

To display the list of confirmed transfer notifications, select the menu Secondary market -> Transfer 
Notification List, enter filtering criteria and press the refresh button. 



 

 

 

 

Figure 74 – Transfer Notification screen. 

The filtering criteria include the corridor name, the horizon, and the transfer period (start and stop). 

The list of notifications determined by the filtering includes the major characteristics of the transfer (transferee, 
rights holder, auction ID, corridor, transfer status, transfer period, type, and Action). 

The details section provides additional information including the capacity right contract from which rights were 
ceased and the schedule of transfer over the transfer period. 

 To confirm a transfer notification: 

• Select the transfer notification to be confirmed (current status of this transfer should be UNCONFIRMED). 

• Click on the “Confirm transfer” icon in the Action column 

• The transfer is confirmed right after the click on the “Confirm transfer” icon. 

 To cancel a transfer notification: 

• Select the transfer notification to be cancelled (current status of this transfer should be UNCONFIRMED). 

• Click on the “Cancel transfer” icon in the Action column. 

• The transfer is cancelled right after the click on the “Cancel transfer” icon. 
 
 

 

2.7.2 Resale of capacity rights 
Resale is managed by the capacity auction system as a financial transaction. There is a compensation of the resold 
capacity. 

The resale must be declared to the capacity auction system through a Resale Notification. This operation can be 
done either through the file upload of a Resale Notification ECAN Rights document v4r0 document or using the New 
Resale screen in the GUI. 

The update of the right portfolio is made as soon as the resale request has been accepted. 



 

 

In case of resale rejection, the system only generates an acknowledgement with a negative status and reason for 
rejection. 

 

2.7.2.1 Resale Notification submission rules 

In order to be properly integrated by the system, resale notifications must follow some rules: 

• Resale notifications must be received during the LT Resale gate of the target auction: this usually 
takes place after auction creation and before bid submission. 

• Reseller must be the owner of the capacity to be resold. 

• Reseller must be a registered Capacity trader. 

• The source auction product must be the same auction product as the target auction product, i.e. 
Yearly Base can only be sold to Monthly Base, and Yearly Peak can only be sold to Monthly Peak. 

• A Resale notification document should contain one resale from one single auction to one single 
shorter- term auction. 

• Released capacity is a constant volume if the shorter-term auction is a monthly auction. 

• Resale period is the delivery period of the target auction (one month if the target auction is a monthly 
auction; one day if the target auction is a daily auction). 

• Yearly capacity can be resold only to the next monthly auctions, taking into consideration the resale 
deadline of 5 working days (therefore on the 16th of April 2023 a Market Participant can do a resale to 
Monthly auctions of May 2016, but he can’t do a resale to Monthly auctions of June 2023). The Market 
Participant can ask JAO to deactivate this rule, once he paid the whole remaining due amount for the 
yearly capacity. 

• The amount of released capacity must be less than the minimum available capacity considering all 
hours of the resale period. 

• To modify resale notifications, higher version of those resale notifications with same document 
identification should be issued. 



 

 

• To cancel a resale, you should declare a higher version of resale notification with an amount of 
resale equal to 0. 

 

2.7.2.2 New Resale Notification through GUI 

Users can declare a new resale notification through the menu Secondary market -> ‘New resale notification’ 
 

Figure 80 – New resale Notification menu option. 

 

 To declare a new resale notification: 

• Resale notification General Parameters: 

Find the auction by filtering the parameters below 

o Corridor: Select the corridor from drop down list 

o Source horizon: Select the LT source horizon (Yearly, seasonally...) 

o Target horizon: Select the target horizon (Quarterly, Monthly…) 

o Resale period: Select the Year and Month if the target horizon is Monthly 

• Click on Refresh button. The participant can now select the auctions (source and target). 

o Capacity Right identification 

▪ Source Auction identification: Select the source auction where the rights were 
acquired from the drop-down list 

▪ Target Auction identification: Select the target auction where rights will be 
released from the drop-down list. 

o Resale Notification schedule 

▪ Specify the quantity to be released out of the available releasable capacity for each 
hour of the resale period. 

✓ As a shortcut to determine the released capacity, users can specify a 
percentage of the available releasable capacity and press the “Set for whole 
period” button. 



 

 

 

 

Figure 81 – New Resale Notification screen. 

 
The submission of the resale notification to the explicit auction system is immediate as soon as the ‘Save’ button is 
pressed. 

 

2.7.2.3 New resale notification through File Upload 

The procedure to upload a resale notification file into the capacity auction system is the generic procedure to 
upload a file into the capacity auction system. 

It is done from the File Upload screen. The parsing follow-up and the review of acknowledgement can be done 
with the File Download screen. 

Please refer to preliminary sections to get the detailed instructions on how to upload a file, check the 
acknowledgement status and review the details of acknowledgement. 

 

2.7.2.4 Resale notification control 

With the Resale Notification display, participants have access to all resale notifications they have submitted. 

To display the list of confirmed resales notification, select the menu Secondary market -> ‘Resale 
Notification List’, enter filtering criteria and press the refresh button. 



 

 

 

 

Figure 82 – Resale Notification list screen. 

 
The filtering criteria include the corridor name, the horizon of the original auction (yearly, seasonally, quarterly or 
monthly), the horizon of the target auction (seasonally, quarterly, monthly) and a period intersecting the searched 
resale period. 

The list of notifications determined by the filtering includes the major characteristics of the resale: resale, 
identification, version number, corridor, source auction where original rights were acquired, target auction where 
rights are released, resale status, resale period and actions (open, download, or modify resale). 

The Resale Identification tab of the details section provides additional information including the capacity right 
contract from which rights were released, the version of resale notification, a detailed description of the target 
auction. 



 

 

 

 

Figure 83 – Resale identification tab in Resale Notification screen. 

 
The Resale blocks tab of the details section gives the amount of released quantity from the yearly, seasonally, 
quarterly auction to the seasonally, quarterly, monthly auction through the selected resale. 

 

Figure 84 – Resale blocks tab in Resale Notification screen. 



 

 

2.8 Capacity Right Portfolio Management 
The capacity auction system maintains portfolios of capacity rights. 

Capacity rights portfolios are created or updated upon 

• Publication of allocation results 

• Auction cancellation 

• Transfer 

• Resale 

• Capacity curtailment 

 
The details of transactions leading to an update of capacity right portfolios can be checked by participants at any 
time in the Capacity right list screen. 

 

2.8.1 Review details of capacity right portfolio 
Users can review the details of capacity right portfolios through submenu ‘Capacity right list’ in Capacity right 
menu. 

 

Figure 85 – Capacity right list menu. 
 

Figure 86 – Capacity right list screen. 



 

 

The filtering criteria include the corridor name and the contract type. 

The list of contracts determined by the filtering includes the major characteristics of the contracts: corridor, contract 
type, contract identification, auction identification, product name, and status. 

To get the details of the portfolio for a given day of the contract period, users should select that day in the Details 
section. 

For each hour of the selected day, users can see a column on the left indicating the current value of capacity rights, 
and a column on the right for each transaction leading to a change of capacity rights: auction, resale, auction 
cancellation. Lost Rights appear with a minus sign. 



 

 

2.9 ITR Designation 
Capacity traders that are not Interconnection Trade Responsible (ITR) on the corridors where they bid must declare 
the parties that will play the ITR role on both in Area and out Area of those corridors. This is managed by the capacity 
auction system and generally set up when the capacity traders register to the system. 

The ITR designation can also be redefined per auction. 

The deadline for such ITR designation change is the gate at the end of which programming authorizations are 
issued. 

Capacity Traders have an interface in the participant UI to set the ITR designation for a given auction manually in 
the New ITR Designation screen. 

In case they do not have access to the capacity auction participant UI, they may request JAO operators to perform 
that operation on their behalf through file upload. 

 

Limitation on ITR Designation 

A new ITR designation submitted on day D before LT programming authorization gate applies for all the rights 
acquired on the target LT auction from D+2 up to the end of the rights period. 

Please, refer to diagrams below to understand how this limitation applies: 
 
 

 

 

 

Figure 87 – Applicability of ITR Designation. 
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2.9.1 New ITR Designation through GUI 
Users can declare a new ITR designation through submenu ‘New ITR Designation’ in the Programming 
Authorizations menu: 

 

 

Figure 88 – New ITR Designation menu option. 

 

Figure 89 – New ITR Designation screen. 

 
  To declare a new ITR designation: 

• Filtering criteria: the purpose of the filtering criteria is to select the auction where ITR designation will 
be changed. 

1. Select Corridor, Horizon, Delivery date start, and Delivery date stop (Delivery date start 
and Delivery date must intersect with the target auction) 

2. Press the Refresh button. 

3. Select the auction from the Auction Identification drop down list. 

• Default ITR parties: This is only an information and cannot be changed. It tells who the default ITR is. 

• Current ITR parties for this designation: This shows the current ITR designation of the remain 
auction period. The ITR of the in area and out area can be changed here. 

Once new ITR designation is done, press the Save button in order to submit the change. 



 

 

2.10 Programming Authorization Management 
LT and day-ahead Programming Authorizations are hourly data related to contracts associated to capacity rights. For 
a given trader, they correspond to the finalized capacity right portfolio for the target market day. 

Programming Authorizations are dealing with a single given market day. 

LT Programming Authorizations for a given market day are generated the day before the daily auction of that market 
day (in D-2, where D is the delivery day). This gives time to execute the LT nomination process and let TSOs determine 
the ATC for the daily auctions. 

Every day, one file per domain is sent to each ITR party collecting all long-term programming authorizations related 
to the given domain for which they will play their ITR role and nominate. 

Every day, one file per domain is sent to each Capacity Trader party collecting all long-term programming 
authorizations related to this domain for which they will play their ITR role and nominate, and/or one file per domain 
containing the long-term programming authorizations related to this domain on the capacity right contracts they 
obtained as traders if they are not ITR. 

Every day, one file per domain is sent to each ITR party collecting all daily programming authorizations related to 
this domain for which they will play their ITR role and nominate. 

Every day, one file per domain is sent to each Capacity Trader party collecting all daily programming authorizations 
related to this domain for which they will play their ITR role and nominate, and/or one file per domain containing 
the daily programming authorizations related to this domain on the capacity right contracts they obtained as traders 
if they are not ITR. 

 
Details of Programming Authorizations can be seen in the Programming Authorizations screen (Programming 
authorizations > Display menu). 

 

Figure 90 – Programming Authorizations menu. 



 

 

 

 

Figure 91 – Nominations and Programming Authorizations screen. 

 
The filtering criteria include the TSO oriented corridor name, the contract type (yearly, seasonal, monthly, periodic, 
intraday, daily…) and the market day. 

The list of contracts determined by the filtering includes the major characteristics of the contracts on which 
programming authorizations have been determined: market day, TSO border, rights holder, Out party, In party, 
contract type, contract identification, auction identification, and Capacity type (PTR or FTR). 

Select a contract among the list to get the details of the Programming Authorizations for the selected day on that 
contract. 



 

 

2.11 Settlement 

2.11.1 Display invoices screen 
This screen is dedicated to the issued invoices for the parties. 

Each party can see their own invoices issued for each month. 

To access the screen the user must go to Invoices option under the Settlement menu. 
 

Figure 92 – Invoices option - Settlement. 

The screen is composed of two areas: 

• Filter area 

o Invoicing period 

o Type 

o Status 

• Invoice display area 

o Invoicing month 

o Accounting document ID 

o Type 

o SAP Invoice ID 

o Amount excl. tax (EUR) 

o Status 

 
To display the wanted invoices, select the desired filters, and click on the Refresh button. 



 

 

 

 

Figure 93 – Display invoices screen. 

 

2.11.2 Updating status of invoice 
The invoices can have only one status at one time. 

The available statuses are: 

• N/A – When the invoice is generated. 

• Issued – 16th working day of the month (invoiced the M-1 period). 

• Overdue. 

• Paid. 

 
To update the status of an invoice, SAP files must be submitted to the system. 

The flow of invoice status is one of the following: 

• N/A -> Issued -> Paid. 

• N/A -> Issued -> Overdue. 
 

 

Figure 94 – Paid/Overdue invoices. 

An invoice can’t go from the state N/A to Paid or Overdue directly, they first must go through the status Issued. 



 

 

3. Online Help 
All users of the web interface have access to the online Help. 

By clicking the menu Help, a pop-up window will open the help documentation. 
 

Figure 95 – Help menu for Participants. 

 

Figure 96 – Help screen. 
 

 
To leave Help screen, click on the gray area around the Help screen. 

 


